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Introduction to WinConnect
Product Description
WinConnect is a software solution that enables Linux-based terminals to connect to Windows® 2000
and Windows® NT 4.0 Terminal Servers, Windows XP or Windows Vista via Remote Display Protocol
(RDP). Because most of the processing is done on the Windows servers, users can display the latest
Windows® applications on computers that normally would not be powerful enough, making use of a
486, an old Pentium computer or a personal digital assistant (PDA).
The connection can be over a local area network (LAN) or over the Internet. A broadband Internet
connection over digital subscriber line (DSL, ADSL) or Integrated Services Digital Network (ISDN)
connection improves performance, but it is not necessary because Remote Desktop transfers only the
minimal data (such as display data and keyboard data) to remotely control your Host computer.
Therefore, even low–bandwidth Internet connections or a wired or wireless TCP/IP connection, local
area network (LAN), wide area network (WAN), dial-up (Internet), virtual private network (VPN)
connection allow you to remotely connect to your office computer.
Users on the Linux-based PCs and Thin Client devices (such as terminals, Internet/ Information
Appliances and PDAs) may run the same or different applications simultaneously and independently to
create and edit documents, and to share peripherals, for example, CD-ROM, printers and other
hardware installed on the Host computer. All users can also surf the Internet and access emails at the
same time and even share network access with unique customized desktop and login.

Hardware Requirements
The recommended Linux desktop requirement to run WinConnect is:




486 or higher
Linux operating system with X-Windows® System installed
16 megabytes of RAM (depending on supported display resolutions)
400 kilobytes of disk space (storage for the program executables and for stored connection profiles)
 Display adapter with Linux driver support

Manufacturer’s Notice
The WinConnect allows multiple users to simultaneously and independently share the same hardware
and software installed on the Host computer. Some software is licensed for use on a single computer
while other software may be licensed for single or multiple users. It is the responsibility of the
WinConnect purchaser/user to read and comply with the licensing agreements of any software that may
be used on the RDP devices.

Terminology
The Host is the Windows® terminal server.
The Client is the Linux-based computer or Thin Client devices (such as Terminal, Internet/Information
Appliance and PDA) where WinConnect software is installed.
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1. WinConnect Remote Desktop Client Setup
1.1.

Installing the WinConnect Remote Desktop Client Software for Linux
System

Installation is simple. By following these steps, a WinConnect system should take less than 15 minutes to set
up. Each step is explained in detail in the following pages.

Step 1.
If installing from a WinConnect CD-ROM, insert the CD. If the Setup program does not run
automatically, open a terminal session/window, and run the setup.sh script by entering the
command:
sh /mnt/cdrom/setup.sh
WinConnect Remote Desktop Client software is also available for download at
www.thinsoftinc.com. If installing from a download, place the self- extracting setup file in a
temporary directory and run it by entering the following command (depending on the file you
have downloaded: “standarddemo56” or “standarddemo128”).
sh standarddemo56.sh
or
sh standarddemo128.sh

Step 2.
Follow the instructions on the screen. After reading and accepting the license agreement, click on
the “I Agree…” button and you will be presented with some install options.
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Step 3.
At the bottom of the Setup window, you will see a “Begin Install” button. Click the “Begin
Install” button to begin the installation.

Note: the “Begin Install” button will be disabled if WinConnect is already installed on
your system. To refresh or update an existing copy of WinConnect, you should
uninstall the existing version first.

Step 4.
Congratulations! You have now fully installed the WinConnect Remote Desktop Client software.
Click “View Readme” or “Exit” to quit from the setup program.

1.2

Running the WinConnect Remote Desktop Client Software on Linux System

On a Gnome desktop, a menu entry is created under Programs, Applications, WinConnect.
You can also run WinConnect from a terminal session/window by running the command:
winconnect
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1.3.

Connecting to a Windows Terminal Server

When the WinConnect user interface is invoked, the browser results are displayed in the “Available Terminal
Servers” section of the WinConnect screen. All Windows Terminal Servers located on the same subnet as the
WinConnect computer should be displayed, listed by both their NetBios name as well as their IP address.
Highlighting the desired server will un-gray the lower right-hand “Connect” button and clicking this button
will establish the connection to the server.

1.4.

Customizing a Terminal Connection

The “Stored Profiles” section of the WinConnect screen contains four icon buttons: Connect, New,
Configure and Delete. Once a Connection profile has been created, its name will appear in the Connection
listing window. Clicking the Connect icon will establish the connection using the properties of this connection
profile. If more than one connection profile exists, clicking the drop-down arrow will display all the profiles.
To create a new connection profile, click New.
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On the General tab, there are required entry fields for naming the connection profile and the address of the
server desired. There are also optional fields for a User ID and automatic login to the server. It is also possible
to click the box to make a profile the default profile. The profile that is made the default will always be the one
to show in the Connections listing window when WinConnect is first invoked. Also, if WinConnect is run from
a terminal session/window with the –c switch (winconnect –c), a connection will be established to the server
using the default connection profile without invoking the WinConnect user interface. Finally, there is a dropdown menu of different keyboard language options. Clicking Save will preserve any changes.

On the Display Options tab, there are radio buttons for setting desired screen areas and full screen option.

In full screen mode the Windows desktop will occupy the entire Linux screen. All hotkeys are passed on to
Windows. In this mode, your WinConnect session will most closely resemble an actual Windows computer. In
addition, WinConnect is optimized for full screen mode, so you will see the best performance. When running
in full screen mode, you cannot switch between WinConnect and other Linux applications. This could be an
advantage if you are a network administrator who wish to restrict the user to running WinConnect only.

The enhanced Color Depth option of WinConnect requires a connection to a Windows Server 2003. This
includes the 'Remote Desktop' feature built into Windows XP Professional and Windows Vista.

8

To enable 24-bit color under Windows XP Professional or Windows Vista, you must also add a Registry entry
on the XP or Vista computer. Run RegEdit and browse to:
HKEY_LOCAL_MACHINE
System
CurrentControlSet
Control
Terminal Server
WinStations
RDP-Tcp
and add a DWORD value:
ColorDepth = 4
To make a Windows XP Professional or Windows Vista system visible to
the WinConnect browser, run RegEdit and browse to:
HKEY_LOCAL_MACHINE
System
CurrentControlSet
Control
Terminal Server
and add or edit a DWORD entry:
TSAdvertise = 1
The easiest way to set these options is to download the registry file posted on our web site at
http://www.thinsoftinc.com/EnableRem-Adv-Col.reg. Select “Open”. When you are asked “Are you sure you
want to add the information in [filename] to the registry?” answer “Yes”. This will automatically update the
registry with the required values, so you not need to run RegEdit.
On the Advanced Options tabs, there are check boxes for disabling mouse motion and drag events, which
help to improve performance. The options are:


Disable Window Manager Decorations (borders, etc) - To set the override redirect window property to
turn off the window manager frame. The window will be displayed in the extreme top left of the screen,
rather than being positioned by the window manager. This option is designed to allow a full screen mode.

 Disable Mouse Motion Events - To stop WinConnect from sending mouse motion events to the remote
computer, except when a mouse button is pressed. Disable the option conserves bandwidth, but may
cause some Windows applications to behave in unexpected ways.

 Disable Mouse Drag Events – To stop WinConnect from sending drag events to the remote computer.
Windows applications will see the drag start and end, but they will not see any intermediate mouse
movements. Disable the option conserves bandwidth, but may cause unexpected effects.

 Enable Data Compression – Selecting this option allows data sent between WinConnect and the remote
computer to be compressed. It helps to conserve bandwidth at the cost of some processing time.

 Connect to Server Console Session – Selecting this option allows WinConnect to connect and take over
the server console session instead of creating a new RDP session. This function will only work with
Windows Server 2003. Default is “Disabled”.
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Enable Zoom – The zoom feature is intended for use on devices with small displays such as handheld;
however, it will only work on desktops in a window. Using the resolution options, you can instruct
WinConnect what size the Windows desktop should be. In the zoom mode, the height and width of the
WinConnect window will be one half that size. Use the Zoom key to zoom the display in and out.

On the Drives tab are entry fields for enabling the local drives in the Linux machine to be able to access from
the Remote Desktop session. Check the “Export path” box and supply the Linux path to the file system
location that you wish to map.
There are also check boxes to map the removable media to the Windows RDP session such as floppy and
CDROM drives. To map a floppy or CD drive, check “Automount” and supply the Linux path to the drive.
The software support up to two of each drives.
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On the Printer tab are entry fields for enabling a printer connected to the Linux machine to be able to print
from the Remote Desktop session. The local printer must first be installed and configured to print normally
from the Linux computer prior to configuring WinConnect for local printing. For printer setup, refer to the
section “Configuring a Printer ”.

On the Serial tab are entry fields for enabling a serial printer or modem connected to the Linux machine to be
able to print or communicate from the Remote Desktop session. Enable the serial port where the device is
attached in the Connection Settings. For more detail on the serial device setup, refer to the sections
“Configuring a Serial Printer” and “Configuring a Serial Port Modem”.
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On the Sound/ Keys tab are entry fields for setting desired audio quality and keyboard mapping. The options
are:


Enable sound – To enable the sound feature.



Use safe sound instead of enhanced sound - On some systems, sound enhancement techniques used by
WinConnect may result in distorted sound. Selecting this option may correct the problem. The default is
not to use this option and leave the box unchecked.

 Send PC scan codes directly - Selecting this option provides the maximum compatibility with Windows
and provides support for the largest number of national keyboards. In some environments this option is
necessary for correct keyboard mapping. This option should be deselected when using WinConnect with
VNC. The default is for this option to be selected.

 Override local windows manager keyboard shortcuts - When WinConnect is running in windowed
mode, hotkeys are used by the local Linux computer. Select this option if you wish to pass on the hotkeys
to Windows when WinConnect is the focus application. The default is not to use this option and leave the
box unchecked. Note that when WinConnect is running in full screen mode, this option is automatically
selected.
The sound feature of WinConnect requires a connection to a Windows Server 2003. This includes the 'Remote
Desktop' capabilities built into Windows XP Professional and Windows Vista.
Sound support also requires installing the "sox" program on the WinConnect computer. The sox program
can be found at:
http://sox.sourceforge.net
It is installed as a standard package by most Linux distributions, for example Red Hat and Mandrake. In this
case you do not need to download and install it.
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Menu Options
Additional options are available from the menu bar at the top of the WinConnect user interface.

The File menu has several features.

New Connection is used to create new Connection profile.
Connect establishes the connection to the Terminal Server using the properties of the Connection profile.
Delete removes the existing Connection profile.
Configure Connection allows users to configure the properties of the Connection profile that has been
created.
The License menu is used to register the WinConnect software.

To register the software, select “License” from the WinConnect menu and then select “Individual License” to
license a single copy of WinConnect or “ Site License” to license multiple copies of WinConnect. For more
information on WinConnect Individual/ Site License Activation, kindly refer to the section
“Registration/Licensing” of the User Manual.
The Options menu enables WinConnect to detect disconnect condition faster (a minute or so) and terminate
the RDP connection.

The Help menu provides the WinConnect version information.
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2. Configuring a Printer
2.1.

Setting Up a Printer in Red Hat Linux 7.2

Follow the instructions below to configure your local printer with printconf under Linux. To use printconf, you
must have the root privileges under Linux.

Step 1.
On the GNOME desktop, select Main Menu Button (on the Panel) => Programs => System
=> Printer Configuration to start the graphical version.
You can also run the "printconfig" command from a terminal session/window by typing the
command:
printconf-gui

Step 2.
To add a local printer such as one attached to the parallel port or USB port of your computer,
click the New button in the main printconf window.

Step 3.
You should see a window similar to the one below. Click “Next” to proceed.
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Step 4.
You will then see the screen as shown below. Enter a unique name for the printer in the Queue
Name text field, e.g. lp. This can be any descriptive name for your printer. The printer name
cannot contain spaces and must begin with a letter a through z or A through Z. The valid
characters are a through z, A through Z, 0 through 9, -, and _.
Select Local Printer from the Queue Type menu, and click Next.

Note: For the local printer configuration, there are five types of print queues that can be
configured with printconf:
Local Printer — a printer attached directly to your computer through a parallel or USB port. In
the main printer list, the Queue Type for a local printer is set to LOCAL.
Unix Printer (lpd Spool) — a printer attached to a different UNIX system that can be accessed
over a TCP/IP network (or example, a printer attached to another Red Hat Linux system on
your network). In the main printer list, the Queue Type for a remote UNIX printer is set to LPD.
Windows Printer (SMB) — a printer attached to a different system which is sharing a printer over
a SMB network (for example, a printer attached to a Microsoft Windows machine). In the main
printer list as shown in Figure 8-1, the Queue Type for a remote Windows printer is set to SMB.
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Novell Printer (NCP Queue) — a printer attached to a different system which uses Novell's
NetWare network technology. In the main printer list, the Queue Type for a remote Novell
printer is set to NCP.
JetDirect Printer — a printer connected directly to the network instead of to a computer. In the
main printer list, the Queue Type for a JetDirect printer is set to JETDIRECT.

Step 5.
Printconf attempts to detect your printer device and display it as shown below. A printer device
attached to the parallel port is usually referred to as /dev/lp0. A printer device attached to the
USB port is usually referred to as /dev/usb/lp0. After selecting your printer device, click Next.

Step 6.
Next, printconf will try to detect what printer is attached to the printer device as shown below.
Select the printer driver from the list. The printers are sorted by manufacturers. Click the arrow
beside the manufacturer for your printer. Find your printer model from the expanded list, and
click the arrow beside the printer name. A list of drivers for your printer will appear. Select the
appropriate printer driver and click on the “Next” button to proceed.
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Step 7.
The last step is to confirm your printer. Click Finish if this is the printer that you want to add.
Click Back to modify your printer configuration.

The new printer will appear in the printer list in the main window. Click the Apply button in the
main window to save your changes and then print a test page to ensure the configuration is
correct.

2.2.

Setting Up a Printer in Mandrake Linux 8.1

Follow the instructions below to configure your local printer with printtool under Linux. To use printtool, you
must have the root privileges under Linux.

Step 1.
Connect a printer to the computer and power up.

Step 2.
Log in as root.
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Step 3.
Open a terminal session/window and run the command: printtool

Step 4.
You should now see a screen similar to the one below. Choose “Add printer” to start the new
printer wizard.

Step 5.
You will be presented with the list of available connections. Choose “Local Printer” if you are
connecting a printer directly to a parallel / USB port of your computer, in most cases the printer
model will be auto-detected.

Step 6.
You need to provide a name for your printer, to easily identify it if you need to, e.g. lp, and
optionally a Printer description and a physical location. Click “OK”.
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Step 7.
Next, you will be presented with the list of supported printers. Check whether Printerdrake did
the auto-detection of your printer model correctly. Search for the correct model or a compatible
model in the list if the cursor is pointing to the wrong model. Click “OK” to proceed.

Step 8.
In the next screen, you will be presented with the settings associated with the chosen driver. If
the settings are correct, click “OK”.
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Step 9.
Set the printer as the default printer and print a test page to ensure the configuration is correct.

The above printer setup can also be accomplished under KDE Main Menu Button (on the Panel) => Control
Center => System => Printing Manager.

2.3.

Setting Up a Printer in Windows Terminal Server

After connecting to the Windows Terminal Server, you will have a new printer available to Windows
applications. Under Windows XP or Windows Vista, this printer will be called something like lp (from XXX)
where XXX is the Linux station name. Under Windows 2000 server, it will be called lp/XXX/ Session 2 where
XXX is the Linux station name.
Printing to this printer from the Windows applications will send print data to your local Linux printer.
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You may be asked to install printer drivers on the Windows Terminal Server if your Linux printer model is not
already available on the server.
To install the printer drivers on the Windows Terminal Server

Step 1.
Connect to a Windows Terminal Server.

Step 2.
On the Windows desktop, select Main Menu Start Button (on the Panel) => Settings => Printers
and Faxes. Right-click on the “lp (from XXX )” printer icon where XXX is the Linux station
name and select “Properties”.

Step 3.
Under Advanced tab, Windows will try to detect what printer is attached to the printer device as
shown below. Select the appropriate printer driver from the list and click on the “OK” button to
save the settings.

If you are not able to locate the Windows printer drivers from the list, click on the “New
Driver...” button to start the Add Printer Driver Wizard. Click “Next” to proceed.
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Step 4.
Select the manufacturer and model of your printer. Then click on “Next” button.

Step 5.
You have now successfully installing the printer drivers. Click on “Finish” to quit from the Add
Printer Driver Wizard.
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Step 6.
Set the printer as the default printer and print a test page to ensure the configuration is correct.

2.4.

Setting Up a Printer in WinConnect Remote Desktop Client
Step 1.
On the GNOME desktop, select Main Menu Button (on the Panel) => Programs =>
Applications => WinConnect.
You can also run WinConnect from a terminal session/window by running the command:
winconnect

Step 2.
Once a Connection profile has been created (refer to “Connecting to a Windows Terminal
Server), click on “Configure” icon.
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Step 3.
All existing Linux print queues can be seen by clicking the drop-down arrow. After selecting the
desired print queue, associate it with a Windows printer driver.
For example, if you had a HP DeskJet 970Cxi printer connected to your Linux system as “lp”,
click on the drop-down arrow of the Windows driver and select the HP DeskJet 970Cxi.
Click “Save” to quit from the connection settings.

If you are not able to locate the Windows printer drivers in the WinConnect user interface, and it
is installed on the Windows Terminal Server, you can enter it manually in the WinConnect user
interface.
As the printer driver must be specified exactly including spaces and capitalization, the easiest way
to do this is to make use of the WinConnect cut-and-paste functionality. Logon to your Windows
server with WinConnect in windowed (not full screen) mode. If your server is Windows 2000,
select Settings->Printers from the Start menu. If the server is Windows XP or Windows Vista,
select Printers and Faxes from the Start menu. Right click on the appropriate printer driver.
Highlight the printer name on the General tab, right click and select copy.
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On the Linux computer, open another copy of the WinConnect Connection Manager. Select the
profile that you wish to edit and select Configure. Place the cursor in the “Windows printer
name” field and press CTRL-V to paste. The correct printer name will be pasted into the printer
configuration.
Alternately, you can add it to the drop down list in WinConnect user interface by editing the file:
/usr/local/share/winconnect/tsprinters

3. Configuring a Serial Printer
3.1.

Setting Up a Serial Printer in WinConnect Remote Desktop Client
Step 1.
On the GNOME desktop, select Main Menu Button (on the Panel) => Programs =>
Applications => WinConnect.
You can also run WinConnect from a terminal session/window by running the command:
winconnect

Step 2.
Once a Connection profile has been created (refer to “Connecting to a Windows Terminal
Server), click on “Configure” icon.

Step 3.
On the Serial tab are entry fields for enabling a serial printer or modem connected to the Linux
machine to be able to print or communicate from the Remote Desktop session. Enable the serial
port where the device is attached e.g. enable Serial Port 0 for COM1, Serial Port 1 for COM2 etc.
Click on the “Save” button to save your connection settings.
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Step 4.
Set the printer as the default printer and print a test page to ensure the configuration is correct.

3.2.

Setting Up a Serial Printer in Windows Terminal Server
Step 1.
Connect to a Windows Terminal Server.

Step 2.
On the Windows desktop, select Main Menu Start Button (on the Panel) => Settings => Printers
and Faxes to start the Add Printer Wizard. Click on the “Next” button to proceed.
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Step 3.
Select the option “Local printer attached to this computer” and click on the “Next” button.

Step 4.
All the available ports can be seen by clicking the drop-down arrow.
Click on the drop-down arrow of the ports listing and select the port where the printer is
connected e.g. TS002 (from XXX ) where XXX is the Linux station name. Click on “Next”
button to proceed.

Step 5.
Select the manufacturer and model of your printer. Then click on “Next” button.
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Step 6.
Assign a name to the serial printer and click on the “Next” button.

Step 7.
You have now successfully configuring the serial printer. Click on “Finish” to quit from the Add
Printer Wizard.
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4. Configuring a Serial Port Modem
4.1.

Setting Up a Serial Port Modem in WinConnect Remote Desktop Client
Step 1.
On the GNOME desktop, select Main Menu Button (on the Panel) => Programs =>
Applications => WinConnect.
You can also run WinConnect from a terminal session/window by running the command:
winconnect

Step 2.
Once a Connection profile has been created (refer to “Connecting to a Windows Terminal
Server), click on “Configure” icon.

Step 3.
On the Serial tab are entry fields for enabling a serial printer or modem connected to the Linux
machine to be able to print or communicate from the Remote Desktop session. Enable the serial
port where the device is attached e.g. enable Serial Port 0 for COM1, Serial Port 1 for COM2 etc.
Click on the “Save” button to save your connection settings.
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4.2.

Setting Up a Serial Port Modem in Windows Terminal Server

Follow the instructions below to set up a serial port modem in the Windows Terminal Server. The Remote
Desktop Client can only be connected to the other computers via Hyperterminal. Dial up Networking is
currently not supported.

Step 1.
Connect to a Windows Terminal Server.

Step 2.
On the Windows desktop, select Main Menu Start Button (on the Panel) => Programs =>
Accessories => Communications => Hyperterminal. Create a new connection and click on
“OK” button.
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Step 3.
The last step is to configure the connection settings and click on “OK” button.

5.

Connecting to a Remote Windows Server
Using a Dial-up Modem

To set-up a Dial-up connection, ensure that the serial ports and modem have been installed; and supporting
Point to Point Protocol (PPP). One way to check for serial-port recognition is to use the dmesg command
under Linux which displays the boot message. Run the dmesg command (piped through the less command) and
look for lines in the output describing serial ports similar to the following:
# dmesg | less
.......
ttyS00 at 0x03f8 (irq=4) is a 16550A
ttyS01 at 0x02fb (irq=5) is a 16550A
ttyS03 at 0x02e8(irq=3) is a 16550A
.........
To check if PPP exist on the system, use the dmesg command again.
# dmesg | less
........
PPP: version 2.3.7
PPP line discipline registered
Another quick way to check if PPP is installed is to use the rpm command.
# rpm -q ppp
ppp-2.3.11-7
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5.1.

Setting Up a Dialer from GNOME Desktop Panel
Step 1.
On the GNOME desktop, select Main Menu Button (on the Panel) => Programs => Internet
=> Dialup Configuration to create a new Internet connection. Click on the “Next” button to
proceed.

Step 2.
If the symbolic link /dev/modem/ does not exist, click on “Add” and then “Next” to query the
modem. If a modem is found, click on the “Keep this modem” and “Next” buttons to select
device as “/dev/ttyS0”.

Step 3.
Enter a name for the dialup account, along with the ISP's dialup number. Then click on the
“Next” button.
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Step 4.
Enter your assigned username and password. Click on “Next” button to proceed.

Step 5.
In the next screen, you will be asked to select your ISP. If your ISP is not listed, just select
Normal ISP and click on “Next” button.
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Step 6.
Click on “Finish” to save the account.

Step 7.
To start your PPP connection, select Main Menu Button (on the Panel) => Programs =>
Internet => RH PPP Dialer.

Step 8.
Select the ISP account that you have created and click on “OK” to start the connection.

Note: In order to connect to Internet successfully, you may need to specify your ISP's DNS
servers in your system's /etc/resolv.conf file.
e.g enter the line using this format:
nameserver 165.21.83.88
nameserver 165.21.100.88

5.2.

Setting Up a Dialer from KDE Desktop Panel
Step 1.
On the KDE desktop, select Main Menu Button (on the Panel) => Internet => Internet Dialer.
You should see the KPPP configuration dialog box similar to the one. Click on “Setup” button.
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Step 2.
Under the Account tab, click on the “New” button.

Step 3.
Click on “Dialog Setup” to create the new account.
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Step 4.
Follow the instructions on the screen. Click “Next” to proceed.

Step 5.
Enter the name of your ISP along with the ISP's phone number.
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Step 6.
Click on the IP tab and select whether it is a dynamic or static IP address assigned to your
computer.

Step 7.
Click on the DNS tab to enter your ISP's DNS IP address.
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Step 8.
Under the Device tab, select the correct modem device and connection speed for your modem.

Step 9.
Under the Modem tab, you can change the default modem AT commands, query your modem,
or test your modem by using KPPP's built-in terminal program. You can also change the
modem's volume by using the slider control in the dialog box.

38

Step 10.
Under the Misc. Tab, you can select or deselect the options according to your preference. If you
click “Dock into Panel” on connect, KPPP will display satiny modem icon with blinking send
and receive lights.

Step 11.
After you have configured the Internet dialer settings, click “OK” and the KPPP windows will
appear as shown below. To start your Internet connection, click on the “Connect” button.

6.

Automating a Terminal Connection

You can run WinConnect from your Linux startup scripts. If the terminal is to be used by multiple users, you
can customize each user’s connection individually.
The script that automatically runs on login can be found in:
/home/user name/.bashrc
As each user runs a different script, these scripts can be customized on a per-user basis.
If WinConnect is placed in the .bashrc script with no parameters, it will run automatically and display the
standard user interface. There are several command line parameters supported by WinConnect that can be used
to customize the connection on a per-user basis. These are:
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-c : If there is a default connection profile defined, WinConnect will automatically connect to the server
using that profile. If there is no default profile, WinConnect will seek out a Windows Terminal Server on
the network. If one is found, it will automatically connect to it.
Example: winconnect –c
Connection name: If you specify a connection profile name, WinConnect will automatically connect using
that profile.
Example: winconnect accounting
Using the connection name parameter, you can edit each user’s .bashrc file to automatically connect them to a
Windows Terminal Server using a different connection profile.
Upon termination of the Remote Desktop session, the user will return to the Linux desktop. If you wish the
user to return to the Linux login, you should add the command “logout” to the .bashrc file following the
winconnect command.
As an example, if you wanted user Rosa to automatically connect to the accounting server on logging in, you
would edit the file
/home/Rosa/.bashrc
You would add the lines
Winconnect “accounting-profile”
logout
to the end of the file. You would then use the WinConnect user interface to create a connection profile named
“accounting-profile” (without the quotes).
If your profile name consists entirely of alpha-numeric characters (no hyphens, for example) the quotes aren’t
required.

7.

Uninstalling WinConnect Remote Desktop
Client Software

Part of the install process is to create a script that will uninstall WinConnect. This script is called "uninstall" and
is in the WinConnect directory. The command to uninstall WinConnect is:
sh /usr/local/share/winconnect/uninstall
Run this script and all WinConnect files, links, and directories will be removed.

8.

OpenLinux problem

Under Caldera OpenLinux 2.4, the link to the terminal server browser program is hidden by a link that
OpenLinux creates to load Netscape. To workaround this issue, remove the OpenLinux link before installing
WinConnect:
rm /usr/bin/browser
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On the OpenLinux 2.4 KDE desktop, a menu entry for WinConnect is not created. You can still run
WinConnect from a terminal by running the command:
winconnect

9.

Browser problem

The WinConnect “browser” program tries to discover the Windows Terminal Servers on your subnet.
Discovered servers are displayed in the WinConnect user interface.
If the technique used by the browser does not work on your network, or if you wish to have terminal servers
outside your subnet appear in the WinConnect “Available Terminal Servers” list, you can manually add
servers to the list by editing the file:
/usr/local/share/winconnect/tshosts

10. Registration/Licensing
To register the software, select “License” from the WinConnect menu and then select “Individual License” to
license a single copy of WinConnect or “ Site License” to license multiple copies of WinConnect.

10.1. WinConnect Individual License Activation
Note: Please make sure that WinConnect is running correctly under demo mode before licensing WinConnect.

Step 1.
In the Internet browser, connect to the web site at:
http://www.thinsoftinc.com

Step 2.
Go to the Purchase, WinConnect Single License web page.

Step 3.
Enter the Ethernet (MAC) address you see below into the form on that web page.
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Step 4.
Continue through the purchasing process.

Step 5.
After a successful purchase, you will receive an unlock code.

Step 6.
Enter the unlock code in the entry box as shown below.

Step 7.
Congratulations! You now have a licensed copy of WinConnect software.

10.2. WinConnect Site License Activation
Note: Please make sure that WinConnect is running correctly under demo mode before licensing WinConnect.

Step 1.
Run the WinConnect user interface on each of the machine to be licensed.

Step 2.
Select License from the WinConnect menu and then select “Site License”.

Step 3.
On each WinConnect machine, select a broadcast socket and click on the “Listen” button. The
broadcast socket should be the same on all machines.
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Step 4.
On a Windows machine on this network, open Microsoft Internet Explorer, connect to the web
site at:
http://www.thinsoftinc.com
and go to the Purchase, WinConnect Site License web page.

Step 5.
An Active X Control will be downloaded to the Windows machine, which will contact all the
WinConnect machines that are listening.

Step 6.
On the Windows machine, complete the licensing steps on the web site and all listening copies of
WinConnect will be automatically licensed.

11. Updating WinConnect
If you wish to update your WinConnect software to the most recent version, you can do so by downloading it
from our web site.
1.

Log in as root.

2.

Download the new version of WinConnect from http://www.thinsoftinc.com.

3.

Before installing, note the unlock code from the WinConnect "Menu>License>Show information"
dialog box.
Note: If you are upgrading from versions prior to 1.3, please email support@thinsoftinc.com for
assistance.

4.

Uninstall the installed version of WinConnect. From a terminal session run
sh /usr/local/share/winconnect/uninstall.

5.

Install the new version of WinConnect following the standard installation instructions.
Restart the computer after successfully installing the WinConnect software.

6.

Use the unlock code saved in step 3 to unlock the new version.

You have now successfully updated your WinConnect software to the most recent version.
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Technical Support
Technical support offered by ThinSoft Pte Ltd
WinConnect products must be registered with ThinSoft before technical support may be offered.
Registration may be completed by registering online at our World Wide Web site. Free support via fax and
email is offered for sixty (60) days from the date of registration. Our technical staff is available to answer
questions, troubleshoot problems and to assist in the installation of WinConnect products. Before requesting
technical support, please be prepared to provide information including the date and place of purchase and
product serial number (______________________).
http://www.thinsoftinc.com
ThinSoft Pte Ltd
23 Tai Seng Drive
#06-00
Singapore 535224
Fax: (65) 6289-7308
email: support@thinsoftinc.com
Support hours are 9:00 to 5:00 local time.
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